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1 HARDWARE AND INSTALLATION 

 
This manual describes all the functions of the program in connection with the GRIMM 
spectrometers.  The catalog number is 1177, the version 3.10. This program is only 
designed to operate in connection with the spectrometer series from GRIMM Aerosol 
Technik GmbH & Co KG, Ainring, as shown below. 
 
1.1 Supported spectrometers 

The software runs with the following spectrometers from GRIMM: 
 
Model 107 in version 7.xx or 8.10. 
Model 180 version 7.80. 
Model 1.101 (Junior). 
Model 1.102 version 2.60. 
Model 1.104 / 1.105 / 1.106 / 1.107 / 1.108. 
Model 1.109 (exception of serial numbers 9Gxxxxxx)/  
Model 7.309 version 9.50 / 9.60. 
 
Limitations 
The software v3.10 does not support spectrometer systems with meteorological station 
or optional attached PAH sensor or the #265systems, which measures Semi-Volatile 
Compounds. 
 
1.2 Computer Specifications 

 
The existing program GRIMM 1177 runs under the operating system  Microsoft 
Windows™ 95/98/ME/2000//XP/NT 4.0. 
 
The minimum hardware requirements are: 
IBM PC – Pentium I or IBM compatible, 
32MB RAM (64 MB under Win ME/2000 recommend), 
CD ROM (software is also available on 3½ disks), 
VGA graphic card with, 
2 GB hard disk,  
VGA Monitor, 1024*768  resolution by 256 different colors 42 cm (17"), 
Printer (color) incl. MS - Windows - printer driver, 
 
The standard hardware requirements are: 
IBM PC  Pentium II or IBM-compatible, 
64MB RAM (128 MB under Microsoft Windows™ ME/2000/XP recommended), 
CD ROM (software is also available on 3½ disks), 
VGA graphic card with  
8 GB hard disk,  
VGA Monitor, 1024*768 resolution  by 16 bit color 42 cm (17"), 
Printer  
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1.3 Operating Specifications 

 
The program runs under the graphic user interface MS-WINDOWS 95/98/ME and 
under MS-Windows NT 4.0/NT 5.0 (MS-Windows 2000)/XP. Previous MS-
WINDOWS versions may be incompatible and should therefore not be used. 
 

Hint  This manual assumes that the user has a good basic working knowledge of 
MS-WINDOWS operating systems and commands. 

 
1.4 Software Installation 

 
1. Start up your computer. Insert the compact disc into your CD-ROM drive or 

Disk 1 into your floppy disk drive. 
2. Click on Start button in the lower-left corner of your Windows screen. 
3. The Windows  Start menu appears. 
4. From the Windows Start menu, select RUN the select BROWSE and select the 

setup.exe from either the CD or floppy drive. The installation program will 
begin. Follow any on-screen installation instructions. 

5. Installation procedure will create a work group called GRIMM 1177. 
 
 

1.5 Initial Software Startup 

 
When you start the software for the first time, 
the user is prompted to install the driver for the 
Spectrometer: 
 

1. Start the program. 
2. Open the menu [OPTION -> SYSTEM].  
3. Click on [Driver]. 
4. Click [Load driver]. 
5. Browse to the location of the driver file for your Spectrometer, select it, then and 

press [OK]. The software loads the driver and stores the data in the file user.ini.  
(Driver file is on CD in the directory “...\Driver” or on a separate disk)  

6. Press the button [OK]. The program will automatically close. 
7. Restart the program. 
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Attention  If the driver file is not displayed in the dialogue box, viewing system files is 
not enabled on your computer.  Please contact your IT department.  

 
 
1.6 Connection and Set Up of the Spectrometer 

 
This program is used to transfer data to and from the spectrometer using the serial COM 
port of the user’s PC for configuration purposes and data retrieval. . 
 

Attention  Use only the Grimm RS232 cable (#1.143) or you may damage your 
spectrometer and/or the computer.   
 
Please read the hardware user manual before setting up the serial connection 
between the spectrometer and the PC. 

 
Turn the spectrometer on  (see user manual of the spectrometer for details). After a 
short startup period the display on the dust-monitor will show the model and the version 
number of the monitor as well as the current date and time. 
 
After that the spectrometer displays the following message: 
 
FILTER CHANGED? 
PRESS +:  YES -:  NO 
 
Press the key [+] only if you have changed the old filter, otherwise press 
the [-] key. The software will now control the spectrometer. 
by the software, click on the standby mode. 
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2 WINDOWS OPERATING SYSTEM 

 
2.1 Background Program 

 
MS-WINDOWS can have several programs running simultaneously with either one or 
no programs in the foreground, all the remaining programs work in the background. The 
computer can passively or actively execute other work programs for which they require 
no interaction of the user. 
 
 

 
 
The Grimm 1177 Software can be switched to run in the background. In the meantime it 
is possible to work with other software. The GRIMM 1177 software will gather all data 
during this time invisibly in the background. 
 
Each active program deprives the computer of certain calculating power. Therefore, if 
many programs run simultaneously, the computer can offer for each individual program 
only a little calculating power. The consequence of this is that some programs get 
insufficient calculating power to fulfill tasks or that the programs are now very slow.  In 
this case you must terminate some programs. 
 
2.2 Executable Files 

The main files are “1177v3.exe. and “cfx32.ocx”. The file “1177v3.exe” is the main 
program and the file “cfx32.ocx” is the graphical module (Active X component). The 
Active X component was registered in the MS Windows registry when the program was 
installed.  
 
2.3 Measurement Data Files 

The software writes the data gathered from the spectrometer or a memory card reader 
into two files, e.g.: 

mass1.dm 
mass1.di 

Both files will be written to the directory “…\data”, which is a sub directory from the 
home directory (normally “C:\Program files\Grimm\DustMonitor”). 
 
The filter efficiency data are written in two files, e.g.: 
filter1.dmf 
filter1.dmi 
Both files are written to the directory “…\data”, which is a sub directory from the home 
directory (normally “C:\Program files\Grimm\DustMonitor”). 
 
The software creates a directory named \data (normally “C:\Program 
files\Grimm\DustMonitor\data”). The software saves each measurement file in this 
directory, except a different directory has 

Symbol Key 
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Fundamentals 
The system writes all the measured data to the *.dm files and additional data 
information to the *.di files  (* is the user selected file name).  The additional data 
information is time of the measurement, counts/mass mode, model of the spectrometer, 
etc. 
 

Attention  Both *.dm and *.di files must be stored in the same directory whether the 
data is stored on hard disk or floppy disk.  

 
2.4 File Manager List File 

The file manager list file contains the start time, the measurement mode, the directory 
name and the file name from each measurement file. The name of this file is 
“MEAS.DAT”. 
 
This file is necessary for the File Manager List. You can search for each measurement 
file with the file manager. 
 
NOTE:  The File Manager can not find a measurement file, when you move a 
measurement file in another directory or you delete a file. You must delete the file 
“MEAS.DAT” when you delete all your measurement files for a backup. The program 
will create a new empty file “MEAS.DAT” when you start the software. 
 
2.5 Configuration File 

The following file must be in the home directory. 
 
All information entered in the menu group [OPTIONS] is stored in the file “USER.INI” 
including driver files. 
 
The software creates a new file “USER.INI” with default parameter, when the file does 
not exist. 
 

 

Hint  If you have corrupted executable/command files, reinstall the software and 
run the setup procedures again. 

 
 
2.6 Temporary file 

Com1a.tmp Temporary file for reading the memory card. 
Com3a.tmp Temporary file for reading the memory card with a modem. 
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3 PARAMETER AND DEFAULT SETTINGS 

 
3.1 The Menu Group [OPTIONS] 

All the measurement and display configurations are made in 
this group menu. This is a short overview on the possible 
settings which will be described later in detail.  
 
1) Spectrometer 

Select and enter measurement parameters. 
2) Automatic 

Select and enter the start and end times of up to 20 series 
of automatic measurements or program the timer from 
the Spectrometer. 

3) Graph 
Select and enter all required parameters for display of measurement values. 

4) Sensor 
Enter the calibration data from the analog sensors. 

5) Alarm 
Select the desired values for alarm (e.g.  the TWA value for dust) as well as for the 
attached optional sensors. 

6) Location 
Select and enter the number and the name  and the gravimetric factor for every 
measuring location or place. 

7) System 
Manage the driver list and enter important modem parameters. 

 
 
3.2 Spectrometer Parameter 

First page [Measurement] 
 

The program will ONLY display the options 
available for the instrument being used.  For 
example a Spectrometer Model 1.107 with a 
firmware version of 7.30 will function only in 
Environmental mode and with two sample 
intervals (six second and one minute).   
Therefore, they are the only choices that will be 
available.   
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Measurement Mode 
 
Environmental: PM-10, (Coarse), PM-2.5, PM-1.0 in µg/m³ (TSP optional). 
Shows nly coarse data when [Differential] in the dialogue box OPTIONS  GRAPH  
second page CALCULATIONS. 
 
Occupational health:  Inhalable; Thoracic; Alveolic in µg/m³. 
Mass distribution:  The values are displayed in 5, 8 or 16 size channels in µg/m3 
Count distribution:  The values are displayed in 4, 8, 12 or 15/31 size channels in 
particle/liter. 
 
Sample Period 
 
Interval 1, 2 or 3 second:  These sample periods are only for model 1.108 version 8.60. 
You must select Count distribution and an 8 channel mode in the group multiplex to 
enable the 1, 2 or 3 second sample period group.  
6 seconds - Fast mode 
The values are sent from the Spectrometer to the computer every 6 seconds. 
Only a few spectrometer models can save the data in 6 second interval on the memory 
card 
Interval 1/5/10/15/30 or 60 minutes 
The averaged values are sent to the Spectrometer every 1/5/10/15/30 or 60 minutes to 
the computer. 
 
Multiplex only model 1.108 
The Spectrometer model 1.108 can works with three different size ranges. The normal 
size range is from 0.23/0.30µm up to greater 20µm in 15/16 different size channels. 
This model can also work in a multiplex mode. In this mode the unit has a size range 
from 0.23/0.30µm up to greater 1.6µm OR from 1.6µm up to greater 20µm in 8 
different size channels. This multiplex mode is recommended when you measure only 
in the fine size ranges, e.g. for filter test or permanent measure of coarse particles. 
 
Second page [Unit/C-factor] 

 
Unit parameter 
 
Standby after measuring:   After measurements 
are recorded, the current task is closed and the 
Spectrometer is set to Standby Mode  
When this option is disabled is disabled and you 
use a modem, the program starts the 
spectrometer after receiving the data from the 
memory card.   (note to Germany:  Is this 
correct?  Does the unit actually receive data 
from the data card?) 
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C-factor from location list 
The software sends the C-factor from your location list to the Spectrometer. The C-
factor is independent of the recorded location number.. 
 
C-factor/Location Number 
 
Location number from PC:  The software sends the selected location number from the 
right field [Location:] to the Spectrometer. 
Read memory card from this location:  The Spectrometer sends only the data from the 
memory card which was measured with this location number to the PC.  This will 
shorten the data transfer time as not all the data on the memory card is being transferred 
provided there are not more than one location number..  
 
 
Third page [Computer/modem] 

 
Group [Serial interface] 
Select the serial interface on which your 
Spectrometer is connected with the computer. 
Normally a desktop computer has two serial 
interfaces (COM1 and COM2) and a notebook 
has only one serial interface (COM1). 
 
Group [Baud rate] 
Set the baud rate for the data transfer from the 
memory card to the PC. Normally set the 
fastest transfer rate. If you use a slower 
computer or you have problems with the data 
transfer, then set a slower transfer rate. 

 
Group [Modem parameter] 
Modem on 
If this option is selected, the software establishes the communication with the 
Spectrometer over an analog modem connected to the selected COM port and receives 
the data via analog modem connection. The respective modem settings can be 
configured under Menu OPTIONS  SYSTEM Second page MODEM Phone number: 
Input the area code and the telephone number of the modem connected to your 
Spectrometer. 
 
Proof connection  (verify connection) 
The program calls the Spectrometer and sends the Standby order. The software sends a 
detailed error message if the connection failed. 
 
You must select all the modem parameters, including baud rate and port number in 
the dialogue box [System] second page [Modem].  
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3.3 Automatic start and stop Parameter 

First Page [Presetting with attached PC] 
 

Enter a list of series of up to 30 
sample start and end times. The 
software will start and stop the 
measurement using the entries in 
this list. 
 
To program the Spectrometer for 
automatic measurement: 
1) Insert start date and time in 

your country format. You can 
also open the calendar with the 
down arrow on the right side. 
You can move forward and 
backward month by month 
with the left and right arrows. 
Click on the date and the 
software take this date. 
At next step insert the time in 
your country format. 

2) Insert stop date/time in same format as above. 
3) Check the field [Read memory], if you want to read the data from the internal 

memory or from the memory card at the start time. 
4) Daily automatic measurement start and stop times can be set by simply clicking at 

[Daily] and then selecting the appropriate start and stop times. 
5) Check the field [Modem] and the program will receive the data via the modem 

connection and not from the serial interface. In this case you must input the phone 
number in the field [Enter TEL-Nr.:] in the dialogue box [Spectrometer]. 

6) Press the button [INSERT]. 
 
To erase one entry: 
1) Select the entry to be erased. The entry will be highlighted. 
2) Press the command button [ERASE] 
To quit press the button [END] when you want to leave the program. 
If you want to cancel the complete file, click at [CLEAR ALL]. After all the 
information is entered you can leave the dialog box by pressing [END]. 
 
1) Note that daily automatic measurements CANNOT be mixed with single sample 

measurement data. Therefore you can only activate the [Daily] function if the list 
box is empty. 

2) Select date and time the same way you have set in the MS-WINDOWS under 
[International] your proper date and time format. 

3) Remember to start the automatic measurements with [File->New] 
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Second Page [Presetting without attached PC] 
 

Enter a list of series of one or 
two sample start and end times. 
The software will configure the 
Spectrometer, so that the 
Spectrometer starts and stops 
automatically. 
 
To configure the Spectrometer 
for automatic measurement: 
1) Insert start date and time in 

your country format. You 
can also open the calendar 
with the down arrow on the 
right side. You can move 
forward and backward 
month by month with the 
left and right arrows. Click 
on the date and the software 
take this date. 
At next step insert the time 

in your country format. 
2) Insert stop date/time in same format as above. 
3) Now press [INSERT]. 
4) Repeat step 1...3, if you will input a second start/stop time. 
5) Connect the Spectrometer with the PC and switch the Spectrometer in the Standby 

mode. 
6) Click on the button [Transfer data to Spectrometer] and the software program will 

transfer the commands to the spectrometer. 
7) Switch off the Spectrometer and disconnect the serial cable. 
 
To erase one entry: 
3) Select the entry to be erased. The entry will be highlighted. 
4) Press the command button [ERASE] 
To quit press the button [END] when you want to leave the program. 
 
If you want to cancel the complete file, click at [CLEAR ALL]. After all the 
information is entered you can leave the dialog box by pressing [END]. 
 
It is not possible to program the spectrometer when you use a modem 
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3.4 Graph 

First Page [View channels] 
 

Combo box [Operational Mode] 
Click on the down arrow to open the list. 
Select one of the modes in the list. The 
group [Size Channels] shows the channels 
of the selected mode. 
 
Group [Channels] 
Click on channels to be displayed 
graphically. All activated channels are 
displayed with an "X". 
 
Group [Sensors] 
Click on the sensors to be displayed in the 
graphic. All activated sensors are then 
displayed with an "X". This group is 
invisible, if you do not use an analog 
sensor. 
 
 
 

 
 
Second Page [Calculation] 
 

Group [Real Data/Percent] 
Shows the absolute values or calculate the 
size distribution in percent. The percent 
calculation is only in the mass or in the 
count mode available, not in the 
environmental or occupational health 
mode. 
 
Group [Channels] 
Shows the values accumulative or 
differential. Accumulative means, that the 
values from the different channels are 
added up. Each smaller size channel is 
equal or higher as the previous channel. 
Before the physical unit is the “>” sign. 
The differential mode shows the values in 
size ranges, e.g. the value from 0.3-0.4µm, 
0.4-0.5µm,  
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The program shows the coarse data when you select [Environmental] in the dialogue 
box OPTIONS  SPECTROMETER  MEASUREMENT MODE and [Differential] 
in the group [Channels]. 
 
 
Group [Calculation Volume] 
Shows the values in different physical units. You can choose between particles/µg per 
liter/m³/cubic foot. Standard means that the physical unit is in the count mode 
particle/liter and in the mass modes µg/m³. 
 
Group [Parameter] 
Histogram 
The program shows the measurement values in a histogram when it checked and in a 
time diagram when the field is unchecked. 
 
Sliding average 
The software permits to calculate the mean values continuously from the last 10 
measurements.  This may be of interest on longer data sets if the sudden jump of mass 
changes is not needed.  This function works only in the fast mode. 
 
Calculated surface area 
The software calculates the surface area from the particles. The software assumes that 
the particle is a sphere and calculates the area of these particles. This is an approximate 
value because the particles naturally have many different geometrical forms. 
 

Attention  The software allows you to select an algorithmic calculation .  It is a good 
idea to calculate environmental or occupational health data with PERCENT 
or to calculate occupational data DIFFERENTIAL. The software warns you 
with a red info panel at the measurement window or with a warning 
message, when you export such data.   However, it is useful to calculate the 
environmental data DIFFERENTIAL, because the result is the new channel 
COARSE (PM10 – PM2.5). 
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Third Page [Axis/Zoom] 
 

Group [Concentration scale (Y-axis)] 
Automatic scale 
If you select this button, the software will 
automatically display the highest value shown. 
 
Maximum 
If this button is not activated you have to enter 
your desired limit. The Y-axis will remain at 
the same limit independent of the size of the 
values. This only applies for the linear and the 
3-D graphic.  Values above the limit are not 
shown.  Use only the maximum limit. 
 
The [Calculated Average] function is not 
available in the online mode. The software 
shows the data in the online mode always with 
the selected SAMPLE INTERVAL. 
 

Group [Calculated Average] 
Calculate the mean value for 1 minute or 1 hour or 1 day or 1 week or 1 month. This is 
only possible if the sample interval time (menu [Options->Spectrometer]) is lower than 
the average time. This function is not available in the online mode. 
 
Forth Page [Graph] 

 
Group [Graph view] 
 
Save Graph View 
Save the user parameter of the measurement 
graph and of the sensor graph. The program stores 
the size, color and view of the graph. 
 
Reset Graph View 
Delete the user parameter of the measurement 
graph and of the sensor graph and set the default 
parameter. 
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3.5 Sensor Calibration Data 

 
Grimm Spectrometers are capable of 
measuring with one to four auxiliary  
environmental sensors i.e.  temperature, 
relative humidity, air velocity, pressure. 
 
The corresponding parameters (factor, 
offset) for each sensor match only with the 
selected instrument.    
 
The software can read the calibration data 
from your analogue sensor, when you 
press the button [Scan Sensor Data]. It is 

necessary for the spectrometer to be in STAND BY mode and to be connected with the 
sensor connected and attached to a computer.. 
 
Only GRIMM sensors with the serial number xxExxxxx have implemented an EPROM, 
which contains the calibration data. 
 
It is not possible to scan the sensor calibration data from spectrometers with serial 
numbers xAxxxxxx to xDxxxxxx.  It is not possible to scan the calibration data from 
old sensors or from sensors which are not manufactured by GRIMM.  In this case you 
must enter the sensor calibration data manually.   Do not change the sequence of the 
sensors. 
 
To select the correct data enter: 
 
Serial Number 
Enter the serial number of the sensor. When the sensor has no serial number, then enter 
any text. 
The software does not support a sensor when this text field is empty! 
 
Name 
Enter the corresponding name for the sensor i.e.  temperature, humidity, wind speed. 
 
Unit 
Enter the corresponding unit for the sensor i.e. °C, % rH, m/s, Pa. 
 
Factor 
Enter the corresponding span conversion factor for the sensor to convert the voltage into 
the corresponding measured value. 
Example: Temperature sensor with factor 10 means, that 1 voltage depends with 10 °C. 
 
Offset 
Enter the voltage value that corresponds with the sensor value 0. 
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Example: Temperature sensor with offset 2 means, that 2 V is 0 °C. 0 V is –20 °C 
(factor is 10). 

Hint  You can not connect more than three sensors on the analogue input from the 
spectrometer. The fourth sensor is always an internal sensor e.g. barometric 
pressure or differential pressure. 

 
 
3.6 Alarm parameter 

 
Here it is possible to enter the values 
which should be monitored not to exceed 
configured high limits. In the main 
window of the software the number of 
alarms is displayed. 
 
Alarm Channel 
Select the desired size channel for each 
measurement mode you want to record 
as an alarm level. 
 
Alarm value 

Enter the desired alarm value as a number for each mode. 
 
 
3.7 Location list 

 
The Spectrometer can store 
the records for measurement 
for up 99 locations. A short 
name for easier identification 
of the location can be given.  
This short name will appear in 
the window [Measurement] 
group. [Measurement 
Parameter]. 
 
 
 
 

To enter or change a name use the following steps: 
 
1.) Insert the number of the location you want to change 
2.) Enter the new name for this location 
3.) Enter the gravimetric factor (C-factor) for this location 
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4.) Press the command button [INSERT] 
 
To quit press the button [END] 
If you want to cancel the complete list, click on [CLEAR ALL]. 
 
3.8 System parameter 

First page [Driver] 
The program uses individualized and 
customized unit drivers to control 
the Spectrometer and analyze the 
measurement data protocol. The 
driver contains all the information 
about the Spectrometer. You must 
load the unit driver for your 
Spectrometer, before the program 
can work with your spectrometer. 
 
Load driver 
You MUST load your unit driver 
from the floppy disk or from your 

installation CD. The unit driver has the extension *.drv.  Restart the software. 
 
Change active driver 
If there is more than one driver in the list, then you must activate one of the drivers that 
corresponds to the instrument the computer is connected to. 
 
Delete driver list 
Delete all the drivers in the list. 
 

Attention  The software deletes the file USER.INI, when you press the button [Delete 
driver list]. You must load a driver file after the restart of the software and 
you must enter all the parameters in the menu group [OPTIONS]. 
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Second page [Modem] 
 
Group [Modem dialogue] 
This group contains the messages which 
were send from modem to modem. The 
default parameter is valid for many 
countries. Only experienced users should 
change these parameters. 
 
 
 
 
 
 

 
Dialog Description 
Answer Message for a received call 
Arq Message for safety connection 
Busy Message when the line is busy 
Connect Message, when the connection is right 
Dial Order for dialing 
Init Initialize string for the modem 
No connect This message is send to the computer, when the modem gets no 

connection with the spectrometer 
Ring Message, when the modem detects a ring 
 
Group [Modem parameter] 
 
This group contains important modem parameter. The default parameters are valid for 
many countries. Only experts shall change these parameters. 
 
Parameter Description 
Dial type Dial with the old impulse dial or the new tone dial 
Handshake Select the handshake 
Port Select the port where your modem is connected(Default is Com 3) 
Baud rate Select the maximum baud rate for your modem (56 kBaud is 

recommend) 
Rings Number of dial tones, before the modem connect the call 
Wait connect Cancels the call after this time (in seconds), when no connection 

could be established 
Wait redial The software repeats the call after the time in seconds, configured 

under Wait redail, when no connection could be established. 
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Third page [Parameter] 
 
Group [Automatic filename] 
The software creates the file name 
automatically when this check box is 
selected. The file name consists of the date 
and the time and a five digit number. 
 
The program saves the file in the directory 
…\data, which is in the home directory 
(normally “C:\Program files\Grimm 
\DustMonitor”). 
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4 MEASUREMENT 

 
4.1 The Menu Group [File] 

 
In this group you may select the following possibilities: 
1) New 

Starts a measurement directly (online) or reads the 
memo card or activates the automatic measurement 
cycle. 

2) Open 
This option allows you to select a stored data file. The 
chosen file is opened and the values are displayed on 
the screen. 

3) Delete File 
Here you can delete a measurement file. 

4) Create filter file 
Create a new file from an Upstream file and a 

Downstream file. The new file shows the filter efficiency. 
5) Export File 

Create an ASCII text file from a measurement file. A spreadsheet software can 
import this file. 

6) Search file 
Search for an older measurement file. 

7) Print 
Print the report from a measurement or from a filter efficiency file. 

8) Preview 
Preview the report from a measurement or from a filter efficiency file. 

9) Printer configuration 
Select and configure your printer 

10) End 
Terminates your measurement.  

 
 
4.2 Dialog box [New] 

 
If you would like to start a new measurement, start the automatic mode or if  
want to see data from the memo card, select the [New] dialog box. 
 
First page [Numeric] 
 
You can select between three possibilities: 
 
1.) Start a measurement in the online mode 
2.) to read the memo card or 
3.) start the automatic measurement. 

 



 

24 

 
The program will first ask you for a file name for your data if the parameter [Automatic 
file name] in the dialog box [System] is unchecked. 
SCREENSHOT FOR AUTOMATIC FILENAME SELECTION 
 

Attention  Selecting an already existing file name will overwrite the existing data. 

 
After you have confirmed your entry with [OK], the next window appears. 
 
4.2.1 Starting Measurement (Online) 

The Spectrometer displays the data continuously in on-line mode. 
 

Notice  1.) Answer FILTER CHANGED when Spectrometer switched on.  
2.) Spectrometer must be connected to computer with a serial cable (Please 
refer to the user manual of the spectrometer 

 
4.2.2 Automatic Measurement (Automatic) 

Automatic measurement is controlled by the software through the computer. Each 
automatic parameter setting in the dialog box will be carried out automatically. The 
measurement is started/stopped at the time entered in the dialog box [Automatic-
Parameters]. 
 

Notice  1.) Answer FILTER CHANGED when Spectrometer switched on. 
2.) Spectrometer must be connected to computer with a serial cable 

 
 
4.2.3 Reading Memory Cards 

The program read the memory card or the internal memory from the Spectrometer. 
After the data transfer is finish, the program shows a list with the following 
information: 
• Start - Start date/time of measurement 
• Stop - End date/time of measurement 
• Loc - Location number of data measurement. 
 
You must select all the measurement cycles, which you will save on the hard disk. After 
then press the button [Save] and the program save this measurements on the hard disk. 
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The maximum size of one measurement cycle is 32700 data sets. The software divide 
the measurement cycle in two or three files, when the measurement cycle is larger than 
32700 data sets. 
 
4.3 Display Stored Files 

With the menu [File ---> Open file] you can open a stored measurement file. The 
following dialog box is a standard - dialog box (file selector box), as this uses also the 
graphic user interface MS-WINDOWS.   If you have difficulties, refer to your MS-
WINDOWS manual for detailed instructions. 
You can select between [Measurement Files] and [Filter Files] in the combo box [File 
Type]. [Measurement Files] shows you all the measurement files (*.dm) and [Filter 
Files] shows you all the filter efficiency files (*.dmf) from the selected directory. 
 
The chapter 5.5 explain, how you can create a filter efficiency file! 
 
 
4.4 Delete a measurement file 

Select a measurement file and press [OPEN]. The program will delete the *.dm and *.di 
file. 
 
 
4.5 Create filter file 

To create a filter efficiency file use the following steps: 
 

1. Establish and set instrument for either mass or particle size measurements 
2. Insert data memory card into data card slot (NOTE: card must have 

accompanying battery installed inside card or it will not work) 
3. Make a measurement before the filter and save this measurement. This 

measurement is called DOWNSTREAM measurement. 
4. Make a measurement after the filter and save this measurement. This 

measurement is called UPSTREAM measurement 
5. Click File - Create Filter File.   You will be prompted to select the upstream 

file.  Scroll through file or do a wildcard search for the first two letters of your 
file name with the extension of .dm. 

6. Highlight and click OK 
7. The downstream file will appear with the file name of the upstream file in the 

file name dialog box. Scroll down/do a wildcard search/change the file name to 
XXb.dm [where xx is the first two letters of the file name] Highlight and click 
OK. "File Saved!" 

8. The software creates a filter efficiency file.   Choose the menu [File->Open file] 
and a file selector box appears. The software uses the name of the downstream 
file. The extension is *.dmf and *.dif for the corresponding header file. 

9. Select the file type [Filter file] and all the list shows all the filter files in this 
directory. Choose the filter file and open the file with the [OK] button. 
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It is helpful for you, when you use for the upstream file the file name “up… .dm” and 
for the downstream file “down… .dm”.  You can see, which file is a upstream file and 
which is a downstream file, e.g. up01.dm and down01.dm. 
 
 
4.6 Create a text file for a spreadsheet program 

If you would like to transfer your results into a 
spreadsheet or word processor program, simply 
transfer the data in ASCII-format. 
 
To do so, first enter the following parameters, then 
press the button [Export] and select the files to be 
transferred. 
 
Group [Separator] 
Individual measurements can be separated with a 
comma, a semicolon, a space or with a tabulator sign. 
If you work with MS-Excel 5.0 or higher, for 
example, we recommend you separate with a 

tabulator. 
 
Group [Data] 
Option to select to export the measurement data, the service data, the sensor data, or a 
combination of the three possibilities. 
 
Group [Unit Parameter] 
Headline 
Create a headline that describes each column. 
Space line 
Create a space line between each data line. 
Thousand Separator 
Create a thousand separator after each 3 digits after the decimal comma. 
Export 
Create text files that contains the measurement data or filter efficiency data. These files 
can be read from many spreadsheet programs, e.g. MS-Excel®.  The software appends 
the text file when an older text file with the same file name exists!  You can select more 
than one file in the file selector box.  The program creates an ASCII file for each 
selected measurement file. 
 
The export module calculates the data with the chosen parameter in the menu OPTIONS 

 GRAPH  CALCULATION. 
 
The program shows a warning message when you select in the menu OPTIONS  
GRAPH  CALCULATION a combination of calculation algorithmic which is 
normally not meaningful. You can continue with [YES] or you can stop the data export 
with [NO]. 
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Button [Open Excel] 
Open MS-Excel, if  installed, and load the selected text file in MS-Excel. 
The software shows the error message “The specified file was not found”, when MS-
Excel is not installed. 
 
Button [Print] 
Send the selected text files to a printer. 
NEW! You can select more than one file in the file-selector-box. 
 
Button [End] 
Close the dialog box. 
 
 
4.7 File Manager (Search File) 

 
This option will help you to search for specific measurement file on your PC. 
 

The complete file name includes the 
drive character, and all the directory 
names could not be longer than 255 
characters.  
 
The program does not add the 
measurement file in the list, when the 
complete name including the  
directory is longer than 255 
characters! 
 
Group [Search Criteria] 
You can search with the filter [Date] 
or [Mode] or with both search filter. 
 
Group [Date] 
Select a date. A helpful calendar 
opens, when you click at the down 

arrow in the date field. You can set the search filter “before the date”, “only the date” 
or “after the date”. 
 
Group [Mode] 
You can select each combination of modes. The software shows only the measurement 
files, which contains data from the selected modes. 
 
Button [Search Files] 
Press the button [Search Files] after you have selected your search filter. 
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Button [Load Files] 
You can open some files in the list. At first select between 1 or 7 lines in the list. Then 
press the button [Load files] and the program opens all the selected files.  The program 
can not open more than seven measurement files.  
 
Button [OK] 
Close the File Manager. 
 
 
4.8 Print report 

Print a report from the active measurement window. The report contains the mean 
value data and some information about the measurement. 
 
 
4.9 Preview report 

Shows the preview report from the active measurement file. 
 
Symbol Description 
Zoom to fit Shows the complete report page 
100% Shows the report in the original size 
Zoom to width Shows the report to width 
Arrows Without function 
Printer setup Allows you to specify which of several printers will be used to print 

the report and also to configure your printer. 
Print  Print the report 
Save report Save the report as Quick Report file. 
Load report Load an old Quick Report file. 
Close Close the preview window. 
 
 
4.10 Printer Configuration 

Allows you to specify which of several printers will be used to print the report and also 
to configure your printer. 
 
All open windows can be printed by clicking on the [OK]. 
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5 MEASUREMENT DISPLAY 

 
5.1 Numerical and Graphical view 

 
First page [Numeric] 

 
Group [Measurement Parameter] 
 
Start time - Start time of data measurement 
Act. - Time of last transmitted value or Stop time of the loaded measurement file 
Location – Shows the location number and the location name if exits. 
C-Factor - Actual C-factor 
Alarm - The value shows how often the value of the alarm channel exceeded the alarm 
value. 
Battery/Pump -  

Battery: Battery power in percentage voltage of the spectrometer. The displayed 
value will allow you to estimate the approximate remaining operation time of your 
battery. If online power supply is used, it displays the value of 130%.  
 
Pump:  The current required for pump operation (models 1.10x only).  The current 
adjusts the flow of the instrument. The pump operation and pump flow conditions 
are valuable information for trouble shooting and other diagnostics. 
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Group [Measurement data here [Mean Count (particle/liter)] 
Indicate the measurements so far transferred by the Spectrometer. If you evaluate your 
measurement file, see also the median value of the individual channels in reference to 
the entire measurement. 
 
Group [Sensor data] 
Display of the connected environmental sensors. These measurements are sent by the 
Spectrometer to the PC. 
 
Info Panel (Dark grey panel) 
This panel inform you, which calculation algorithm is used by the program on the 
measurement data. You can select the different calculation algorithm in the menu 
[OPTIONS GRAPH Calculation]. 
Real / Percent Shows the real data or calculate the data in percent.  
Accu / Diff. Shows the data accumulative or differential. 
Slid.Av. Calculate a sliding average from the last 10 measurement data. This 

is only possible, when you measure in the 6 second sample interval. 
The panel is red, when you selected in the menu OPTIONS  GRAPH  
CALCULATION a combination of calculation algorithmic, which is normally not 
meaningful. 
 
Measurement Graph 
Show the measurement graph for all selected channels. 
 
Second page [Sensors] 
Shows the sensor graph, if a sensor is connect. 
 
 
5.2 Data Files Displays 

 
Data files may be displayed graphical. The table below describe the symbols in the tool 
bar from the graph. 
 

 
 

 
 
Symbol Description 
Camera Copy a bitmap graph in the clipboard 
Shear Copy the values in the clipboard. 
Printer Print the graph 
Area diagram Shows the data as area diagram 
Bar diagram Shows the data as bar diagram 
Line diagram Shows the data as line diagram 
Point diagram Shows the data as point diagram 
3D Shows the graph as 3D or as 2D graph 
Cluster Shows the values side by side or in succession 
Legend Shows the legend on the right side, if you have choose more than 
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one channel 
Horizontal grid Switch on or off the horizontal grid 
Vertical grid Switch on or off the vertical grid 
Font Change the fonts of all the titles, legend and values 
Tool Switch on or off the legend, color bar, pattern bar and data table 
 
With the help of the horizontal scroll bar at the lower screen board you can move within 
your measurement file. 
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6 EXTRAS 

 
6.1 Statistical Evaluation 

 
The program calculates with the data of a measurement file some statistical values. You 
can calculate with the data of a filter efficiency file too. In this case select in the file 
selector box the file type from “Measurement Files” to “Filter Files” and select a *.dmf 
file. 
  
Order Statistics 
• Minimum 

The smallest value of the data set. 
• Maximum 

The largest value of the data set.  
 
Descriptive Statistic 
• Statistical range 

The statistical range is defined as the difference between the smallest and the 
largest value of a set. 
R = Maximum – Minimum. 
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Moments 
• Arithmetic Mean 

The arithmetic mean of a set of values is the quantity commonly called the mean or 
the average 

• Variance 
The variance is the middle square deviation of  a set of values from the arithmetic 
mean. 

• Standard Deviation 
The standard deviation of a probability distribution is defined as the square root of 
the variance. 

• Variation Coefficient 
The variation coefficient is defined as the division between the standard deviation 
and the arithmetic mean. 
V = s / x. 

  
The important statistical parameters are the variance and the standard deviation.  The 
statistical range is very “runaway” sensitive.  The variation coefficient is scale 
independent and gives you the variability of a measuring better as other parameters. 
 
Group [Date / Time Range] 
You see in the first line from this group the date/time range from the loaded 
measurement file. You can reduce the date/time range with the date/time edit fields 
below. You must calculate the statistical values again with the button 
[CALCULATION], when you change the date/time range. 
 
Group [Data] 
You can select between the measurement data, the sensor data or both. The software 
calculate only the statistical values from the selected data sets. You must calculate the 
statistical values again with the button [CALCULATION], when you change anything. 
 
Group [File Parameter] 
This group shows you some information from the loaded measurement file: 
the mode, the C-factor, the location number, the directory and the name of the file. 
 
Button [Calculation] 
You must recalculate the statistical values when you change any of the parameters in 
this dialogue box. 
 
Button [Load file] 
The program delete the actual data from the (computer) memory and load new 
measurement data. After then the program calculate the statistical values from the 
complete data of the file. 
 
Button [Close] 
Close the dialogue box. 
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6.2 Gravimetric evaluation 

This function allows you to correlate 
the measured mass values to a 
reference value obtained by a 
gravimetric measurement.  
 
Note that gravimetric evaluation is 
not possible for measuring in mode 

COUNTS (particle/liter) as only the numbers of the particles are counted and there is no 
reference to the dust mass. 
 
Procedure: 
Detailed information’s to the gravimetric evaluation take from the spectrometer user 
manual! 
  
1.) Weight the collected dust mass of the filter. Enter this value at the first text field 

[Real Filter Weight]. 
2.) Enter the counted dust mass from the spectrometer in the text field [Calculated 

Filter Weight]. 
3.) Press the command button [Calculate] to calculate the gravimetric factor. 
4.) Overwrite the old C-factor with the new C-factor with the button [Transfer to File]. 

The program change the C-factor in the selected file. When you open this file later 
with [File-->Open], than the programs shows the measurement data include the 
new C-factor. 

 
Do not change the C-factor if you use a spectrometer model 107 (1.107), 180 or 190.  
These units should be run with the C-factor 1.00. 
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7 ABOUT AND HELP 

 
7.1 The Menu Group [HELP] 

The software starts the ADOBE READER® and opens the software manual. This 
feature is not functional, when you do have not installed the ADOBE READER®. 
 
 
7.2 Tutorial Software 

The program starts the tutorial software. The tutorial 
contains information of the spectrometers. 
 
The [Tutorial 1.101 – 1.109]  shows you in some 
pictures, how you can use the different components of 
the spectrometer system. 
 
The [Tutorial 1.165] shows in some pictures, how you 
can build up the weather housing 

 
The [Operation 1.101 – 1.109] 
explains the various possibilities 
of the keyboard of the 
spectrometer. 
 
You must press the red key at 
first, then you must take off the 
key and at last you must press one 
of the yellow key. 
 
Some features are available, when the spectrometer is in the standby mode. Other 
features are available in the running mode or in both modes. 
 
The [Size channels 1.101 – 1.109] shows the size channels from all spectrometer 
models and versions. You must select the spectrometer model and version number in 
the menu [OPTIONS  MODEL], before you open the dialogue box [Size channels 
1.101 – 1.109]. 
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8 TROUBLESHOOTING 

 
No communication with the Spectrometer 
• Check the serial cable. Use only the original GRIMM serial cable, because this cable 

has a special wiring. 
• Use the cable with the catalogue number 1.143E,. 
• Check, that there is no terminal software running in the background,  accessing the 

serial com port. 
• Check if you have selected the right serial port in the software. 
• Check with a serial loop back adapter and special test software, if the serial port is 

damaged. 
• If you use a standard business USB-Serial adapter, then you can not connect this 

adapter directly to the serial interface from the spectrometer. You must use the serial 
cable between the USB adapter and the spectrometer. 

• If you use a GRIMM USB-Serial adapter, then you should connect this adapter 
directly to the spectrometer. 

 
The software is “frozen”, when it runs under MS-Windows XP 
• Run the software in the Windows95 compatibility mode (see chapter 1). 
• Install the latest service pack. 
 
The software is not stable 
• Perhaps you have got a “dirty” computer. The operating system will be instable, if 

you have installed and reinstalled many programs, especially tool programs. In this 
case it is the best to delete your hard disk and install the operating system with the 
latest service packs. 

• Install the software at another computer. 
 
“Range Check Error” appears, when you starts a measurement. 
• You have select a not existing serial port or another program uses the selected serial 

port. 
 
The measurement list is empty after the download from the memory card 
• The memory card contains no data. Proof the battery of the card. If the voltage from 

the battery is lower than 2.7V, then the card can loose data. 
• The memory card contains only count data and you have selected mass data in 

[OPTIONS-->Spectrometer-->Measurement Mode] or the other way around. 
• Check in the menue LOCATION, if you have selcted the right Location number. 
 
The message “The specified file was not found” appears 
• Tutorial. The tutorial software is not installed. 
• Manual. The ADOBE READER® is not installed or the manual is not in the home 

directory. 
• GRIMM Homepage. The MS-Internet Explorer® is not installed, because you use 

an alternative internet browser. 
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